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Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des LSS MasterPort 2 PSU.  

 

Dieses Handbuch gilt für den LSS MasterPort 2 PSU. Wie alle anderen Produkte aus dem Hause LSS 
GmbH unterliegt der LSS MasterPort 2 PSU einer ständigen technischen Weiterentwicklung. Des-
halb werden hier unter Umständen Funktionen und Einstellungen beschrieben, die für den von 
Ihnen genutzten LSS MasterPort 2 PSU nicht verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

 
Hier erhalten Sie zusätzliche Informationen 

  

 

Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen 
Problemen mit dem Gerät oder zu Datenverlusten führen können. 

  

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem LSS MasterPort 2 PSU ist nicht gefährlich. Schutzisolierung und weitere Si-
cherheitsmaßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen 
und Strömen in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 

• Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

• Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

• Öffnen Sie niemals das Gerät! Wenn Sie das Gerät öffnen besteht Lebensge-
fahr!  

• Berühren Sie niemals eine der intern verbauten Komponenten!  

• Reparaturen dürfen nur von Mitarbeitern der LSS GmbH durchgeführt werden. 

 

  



MasterPort 2 PSU 

 LSS 7 
 

 

Hinweise zur Handhabung 

Der LSS MasterPort 2 PSU ist für einen Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes be-
achten: 

 

 

• Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

• Vermeiden Sie extreme mechanische Belastungen! 

• Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

• Wenn nötig reinigen Sie das Display ausschließlich bei ausgeschaltetem Gerät. 
Benutzen Sie nur ein angefeuchtetes Tuch 

• Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung 
auf das Gerät! 

• Decken Sie die Belüftungsöffnungen niemals ab! Brandgefahr! 

• Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 

 

Wir freuen uns über Ihre Hinweise und Kommentare zu diesem Handbuch. Bitte senden Sie diese 
per E-Mail an mail@lss-lighting.de. 

 

History 

 

Datum Firmware Beschreibung 

01/2013 1.01 Erstbeschreibung 

04/2017 1.12 Rev. 14 

1.13 Rev. 13 

Aktualisierung  

05/2020 1.20 Anpassung auf 10 A 

01/2021 1.22 RDM/Art-Net 4, V 

02/2024 2.12 Aktualisierung 
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Der MasterPort 2 PSU 
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Geräteeigenschaften 

Der LSS MasterPort 2 PSU ist ein RDM-fähiger DMX/Ethernet-Netzwerkknoten mit 24 V/10 A 
PowerDMX-Ausgängen. Technisch basierend auf dem LSS MasterPort 2 bietet das Gerät alle Merk-
male eines modernen Netzwerkknotens:  
 

• Wandlung von Ethernet-Protokollen in DMX512-A 

• Einbindung in Broadcast-Domains und VLAN 

• Unterstützt Multicast DNS-Protokolle mDNS und DNS-SD 

• Unterstützung von RDM-Net 

• Mergen von Daten aus bis zu vier Quellen 

 

Die Ausgabe der DMX-Daten kann vom LSS MasterPort 2 PSU als reines Datensignal und/oder Da-
tensignal mit Spannungsversorgung (PowerDMX) erfolgen. PowerDMX bietet neben den Steuerda-
ten eine 24 VDC /10 A Spannungsversorgung für Lichttechnik. Jeder PowerDMX-Anschluss hat eine 
einstellbare Stromüberwachung mit Warn- und Abschaltschwelle. Als Bestelloption können alle 
DMX- und PowerDMX-Anschlüsse auch rückseitig ausgeführt werden. 

 

Der LSS MasterPort 2 PSU ist für verschiedene Einsatzzwecke und -orte als Einbaugerät oder mobi-
les Gerät erhältlich. Je nach Gerät kann die Spannungsversorgung über normale Netzspannung für 
das gesamte Gerät oder über eine getrennte Spannungsversorgung von CPU und PowerDMX-An-
schlüssen erfolgen. Bei der getrennten Versorgung können die CPU und die reinen DMX-
Anschlüsse über PoE betrieben werden. Die Spannungsversorgung der PowerDMX-Anschlüsse ist 
dann über eine zentrale Spannungsversorgung oder Schaltnetzteile zu realisieren. 
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Bauformen 

MasterPort 2 PSU-Einbaugerät 

Als Einbaugerät kann der LSS MasterPort 2 PSU in Versatzkästen, Datenschränken, im LSS-
Multifunktionskanal 180 x 120, im LSS VK-Profil 155 und anderen Gehäusen Anwendung finden. 
Das Gerät ist auch mit rückseitig ausgeführten DMX- und PowerDMX-Anschlüssen erhältlich.  

 

   

Frontansicht Seitliche Ansicht 
Rückansicht mit optionalen 

Anschlüssen 

 

Technische Spezifikationen 

Abmessung (BxHxT) 130 x 153 x 68 mm mit Encoder und Phoenix-Steckern  

130 x 153 x 44 mm ohne Encoder 

(alle Maße ohne Steckverbinder) 

Gewicht 650 g 

 

Bestellnummer 5063 ohne rückwärtige DMX- und PowerDMX-Anschlüsse 

5263 mit rückwärtigen DMX- und PowerDMX-Anschlüssen 
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MasterPort 2 PSU für LSS-Multifunktionskanal 250 x 140 

LSS MasterPort 2 PSU mit verkürzter Frontplatte für den Einbau in den  
LSS-Multifunktionskanal 250 x 140. Das Gerät ist auch mit rückseitig ausgeführten DMX- und 
PowerDMX-Anschlüssen erhältlich. 

 

  

Frontansicht Seitliche Ansicht 

 

Technische Spezifikationen 

Abmessung (BxHxT) 130 x 146 x 68 mm mit Encoder und Phoenix-Steckern 

130 x 146 x 44,5 mm ohne Encoder 

(alle Maße ohne Steckverbinder) 

Gewicht 640 g 

 

Bestellnummer 5063 ohne rückwärtige DMX- und PowerDMX-Anschlüsse 

5263 mit rückwärtigen DMX- und PowerDMX-Anschlüssen 
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MasterPort 2 PSU zur Wandmontage 

LSS MasterPort 2 PSU mit Gehäuse und frontseitig ausgeführten Ethernet-Anschluss zur Montage 
im Aufputzgehäuse an Wänden und anderen, auch unebenen Flächen. Die Spannungsversorgung 
kann nur durch eine externe Versorgung erfolgen. 

 

 

  

 

 

Technische Spezifikationen 

Abmessung (BxHxT) 200 x 155 x 76 mm mit Encoder 

200 x 155 x 68 mm ohne Encoder 

Spannungsversorgung Extern 24V DC 

Kein internes Schaltnetzteil möglich! 

Gewicht ca. 3000 g 

 

Bestellnummer 5063 

Nur mit frontseitigen DMX- und PowerDMX-Anschlüssen erhältlich.  
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MasterPort 2 PSU portable 

Mobiler LSS MasterPort 2 PSU für dezentralen Einsatz. Das Gerät kann in das Lichtnetzwerk einge-
bunden werden, kann aber auch unabhängig von Netzwerk als Stromversorgung eingesetzt wer-
den.  

 

Als optionales Zubehör sind Wandhalter erhältlich, durch die der LSS MasterPort PSU portable an 
einer Wand oder einem anderen Ort dauerhaft fixiert werden kann. 

 

 
 

 

 

Technische Spezifikationen der Ausführung 

Material Seitenwangen:  Aluminium, schwarz eloxiert (RAL 9005) 

Gehäuse:  1 mm Stahlblech, schwarz gepulvert  

Spannungsversorgung 230 V AC mit internem Schaltnetzteil 

  

Abmessung (BxHxT) 216 x 175 x 212 mm 

Gewicht ca. 4500 g 

Schutzart/-klasse IP20/SK1 

Zubehör Wandhalter 

 

Bestellnummer 5063 
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MasterPort 2 PSU RM für 19‘‘ Racksysteme 

Der LSS MasterPort 2 PSU RM ist eine kompakte Geräteeinheit aus MasterPort 2 PSU, Spannungs-
versorgung und Ethernet-Switch. Das Gerät ist wahlweise als 40A Variante mit einem oder als 80A 
Variante mit zwei LSS MasterPort 2 PSU erhältlich. 

 

MasterPort 2 PSU RM 40A 

 

  

Frontansicht Seitliche Ansicht 

 

 

 

Rückansicht Ansicht von oben 

 

Technische Spezifikationen 

19‘‘-Blende 1,5 mm Stahlblech, schwarz gepulvert (RAL 9005) 

Kühlung temperaturgeregelter Gehäuselüfter 

Spannungsversorgung Neutrik powerCon® blue 230 V AC  

Ausgangsstrom 4 x 10A  

Gerätesicherung Rückseitig ausgeführt unter transparenter Klappe 

Ethernet 2x RJ45 (Vorder- und Rückseite) 

Netzwerk-Switch Intern 

Abmessung (B x H) 483 x 178 mm, 19‘‘ x 4 HE 

Einbautiefe Mindestens 273 mm 

Gewicht ca. 3600 g 

Bestellnummer 5063 
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Ansicht MasterPort 2 PSU RM 80A 

 

  

Frontansicht Seitliche Ansicht 

 

 

 

Rückansicht Ansicht von oben 

 

Technische Spezifikationen 

19‘‘-Blende 1,5 mm Stahlblech, schwarz gepulvert (RAL 9005) 

Kühlung Temperaturgeregelter Gehäuselüfter 

Spannungsversorgung Neutrik powerCon® 230 V AC  

Ausgangsstrom 8x 10A 

Gerätesicherung Rückseitig ausgeführt unter transparenter Klappe 

Ethernet 2x RJ45 (Vorder- und Rückseite) 

Netzwerk-Switch Intern 

Abmessung (B x H) 483 x 178 mm, 19‘‘ x 4 HE 

Einbautiefe Mindestens 273 mm 

Gewicht ca. 3600 g 

Bestellnummer 5063 
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Anzeige-, Anschluss- und Bedienelemente 

Frontseite 

Überblick 

Auf der Frontseite des LSS MasterPort 2 PSU befinden sich die DMX-Ports und der Konfigurations-
bereich. 

 

 

 

Betriebsanzeigen 

Menüeinstellungen 

DMX-Out 

Power- 

DMX-Out 

 

 

Anschlüsse 

Die Anschlüsse des LSS MasterPort 2 PSU befinden sich direkt am Gerät. Alle DMX-Ports sind an 
der Frontseite angeordnet, der RJ45-Zugang und die Anschlüsse der externen Spannungsversor-
gung auf der Rückseite. Ebenfalls auf der Rückseite befinden sich sekundäre DMX-Ports, die im 
kommenden Hauptkapitel näher beschrieben werden. 

 

Die einzelnen DMX-Ports bilden mit den darunter befindlichen PowerDMX-Anschlüssen als Einheit 
die 4 Ports des Gerätes. So ist es möglich, den reinen DMX-Daten-Port und den DMX-PSU-Port 
gleichzeitig als ein Universe zu betreiben. 
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Betriebsanzeigen 

Über die LEDs an der Frontseite werden die Betriebszustände des MasterPort 2 PSU angezeigt. 

 

LED Farbe Bedeutung 

Power blau Ein: Betriebsspannung vorhanden 

Aus: Betriebsspannung nicht vorhanden 

LINK/DATA gelb Ein: Ethernet-LINK, keine Daten 

Blinkt: Ethernet-LINK, Daten 

Aus: kein LINK 

ACTIVE/FAIL  Grün 
 

DMX-Port-Sammelanzeige  
An: mindestens ein DMX-Port ist aktiv 
Blinkt: mind. ein DMX-Port erhält kein Signal und ist auf HOLD  
Blitzt: mind. ein DMX-Port erhält kein Signal und sendet NULL (ZERO) 
Aus: Alle DMX-Ports sind aus 

Rot Fehlermeldungen 
Blinkt: Programmierfehler – Service informieren! 
An: Sammelfehler – Service informieren! 

PSU-Power grün Ein: Betriebsspannung vorhanden 

Blinkt: Betriebsspannung nicht vorhanden 

PSU-
Overload 

rot Ein: benötigte Ausgangsleistung zu hoch 

Aus: Ausgangsleistung innerhalb Parameter 

Im Gerät sind noch weitere Diagnose-LEDs vorhanden. Diese sind für Service und Wartung vorge-
sehen. 

 

Power Supply Unit (PSU) 

Der MasterPort 2 PSU kann mit DMX angesteuerte Endgeräte neben Daten auch mit der notwen-
digen Spannung versorgen. Dafür wird über die PSU-Ports eine Spannung von 24 V übertragen und 
pro Port eine Stromstärke von bis zu 10 A zur Verfügung gestellt. Für jeden Kanal kann die Aus-
gangsstromstärke in 0,1 A-Schritten festgelegt werden und durch deren ständige Überwachung ist 
der MasterPort 2 PSU auch in der Lage, den Port bei Überlast selbstständig zu schließen. Mit einer 
eigenen DMX-Adressierung für jeden PSU-Port ist der MasterPort 2 PSU aber auch in der Lage, die-
sen Port zu schalten. Das geht ganz einfach mit einem Signal vom Lichtpult aus. 

 
Die Power Supply Unit wird ständig temperaturüberwacht. Im System sind eine Warntemperatur 
und eine Abschalttemperatur eingetragen, die nur werkseitig geändert werden können. Wird die 
Warntemperatur erreicht, erscheint auf dem Display eine Warnmeldung. Beim Erreichen der Ab-
schalttemperatur werden die PowerDMX-Ports automatisch abgeschaltet und es erscheint eine 
weitere Meldung im Display. Die PowerDMX-Ports bleiben solange abgeschaltet, bis die Tempera-
tur der Power Supply Unit 10 °C weniger als die Warntemperatur beträgt. Die Abschaltung kann 
nicht manuell beendet oder umgangen werden. 
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Menüeinstellung und Display 

Die Konfiguration des MasterPort 2 PSU erfolgt lokal über ein komfortables Menüsystem. Zu die-
sem Zweck enthält das Gerät ein blau-weiß leuchtendes 20x4-Zeichen LCD-Display mit stromspa-
render LED-Hintergrundbeleuchtung und langer Lebensdauer. Die Lebensdauer wird noch um ein 
Vielfaches erhöht, wenn der Bildschirmschoner verwendet wird.  

 

Bedient wird das Menü mit einem Dreh/Drück-Encoder, der bereits vom LSS MasterPort 2 bekannt 
ist. 

 

 

 

Display 

Dreh/Drück-Encoder 

 

 

 

Verwenden Sie den Bildschirmschoner! Dies verlängert die Lebensdauer des Dis-
plays um ein Vielfaches. 

  

 

Im Menü können Sie den Kontrast des Displays einstellen. Ein Nachregeln ist aber 
normalerweise nicht nötig, da das Display bereits temperaturkompensiert ist. 
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Rückseite 

Überblick 

An der Rückseite des MasterPort 2 PSU befinden sich die Anschlüsse zur Spannungsversorgung des 
Gerätes und optionale sekundäre DMX-Ports. 

 

 

 

Spannungsversor-
gung Steuereinheit 

Ethernet 

  

Optionale DMX-
Anschlüsse 

 

 
Spannungsversor-
gung PSU 

Optionale PowerDMX-
Anschlüsse 

 

 

 

 

Spannungsversorgung Steuereinheit 

Die Spannungsversorgung der Steuereinheit des MasterPort 2 PSU kann wahlweise per  

Power-over-Ethernet (PoE) oder mit einem externen Netzteil (24 V DC) erfolgen. Bei PoE erfolgt 
die Spannungsversorgung direkt über den Ethernet-Anschluss. Wird ein externes Netzteil einge-
setzt, erfolgt die Spannungsversorgung der Steuereinheit über den oberen grünen Phoenix-Steck-
verbinder. 

 

 

Wird die Steuereinheit des MasterPort 2 PSU sowohl über PoE als auch über ein ex-
ternes Netzteil mit Spannung versorgt, hat die Versorgung über PoE Priorität! 
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Ethernet 

Der MasterPort 2 PSU ist mit einer RJ-45-Ethernet-Schnittstelle ausgerüstet, die eine IEEE-
Belegung für 100BaseTx und Power-over-Ethernet (PoE) gemäß Standard IEEE 802.3af unterstützt.  

 

Spannungsversorgung PSU 

Die Spannungsversorgung der MasterPort 2 PSU kann wahlweise durch ein externes Netzteil oder 
durch eine zentrale Spannungsversorgung (jeweils 24 V DC, 40A) erfolgen, nicht aber durch PoE. 
Für jeweils zwei Power-DMX-Anschlüsse steht ein Phoenix-Steckverbinder zur Verfügung.  

 

 

Beim Einsatz von externen Netzteilen müssen die Herstellerangaben zu Stromab-
gabe, Wärmeabgabe usw. beachtet werden! 

 

Optionale DMX-Anschlüsse 

Auf besonderen Wunsch (als Bestelloption) können die vorderen vier DMX-Anschlüsse auch rück-
seitig als 4pin-Steckanschlüsse ausgeführt werden. Diese sekundären DMX-Anschlüsse sind zu den 
XLR-Anschlüssen parallelgeschaltet und entsprechen in der Software-Konfiguration immer ihrem 
vorderseitigen Pendant.  

 

 

Die Bestückung mit Steckverbindern ist eine Bestelloption und kann nicht nachträg-
lich realisiert werden! 

 

Optionale PowerDMX-Anschlüsse 

Wie die DMX-Datenanschlüsse können auch die PowerDMX-Anschlüsse rückseitig als sekundäre 
Anschlüsse ausgeführt werden. Sie sind parallel zu den frontseitigen PowerDMX-Anschlüssen ge-
schaltet und entsprechen in der Software-Konfiguration den jeweiligen vorderseitigen XLR-
Anschlüssen. 

 

 

Die Bestückung mit Steckverbindern ist eine Bestelloption und kann nicht nachträg-
lich realisiert werden! 
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Das Menü und seine Einstellungen 
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Hinweise zur Bedienung des Menüs 

Aufbau und Auswahl 

Die Menüstruktur des MasterPort 2 PSU ist hierarchisch angeordnet. Die erste Ebene ist der 
Durchlauf, von dem der Zugriff auf das Hauptmenü erfolgt. Vom Hauptmenü sind die weiteren Un-
termenüs thematisch in Ebenen unterteilt.  

 

Menüauswahl 

Drehen am Encoder wählt die unterschiedlichen Menüpunkte und Schaltflächen durch ein wan-
derndes ►. Ein kurzes Drücken auf den Encoder wählt diesen Menüpunkt oder die Schaltfläche 
aus. 

 

Einstellungen vornehmen und speichern 

In den Hauptmenüs Config und Options werden die Einstellungen für den MasterPort 2 PSU vorge-
nommen. Durch Drehen und Drücken werden Untermenüs aufgerufen oder Einstellungen ausge-
wählt und eingestellt. Erst durch Speichern werden die Einstellungen übernommen und damit 
wirksam. Gespeichert werden die Einstellungen durch Rückkehr in das übergeordnete Menü. Da-
bei muss die Frage, ob die Änderungen gespeichert werden sollen, mit „Yes“ beantwortet werden. 

 

 

Bitte beachten Sie, dass jede Änderung der Einstellungen weitreichende Folgen auf 
Ihre Lichtanlage haben kann. Die folgend beschriebenen Einstellungsmöglichkeiten 
setzen auch voraus, dass Sie Erfahrungen und Kenntnisse in der Konfiguration von 
DMX und von Ethernet-Lichtprotokollen besitzen.  
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Durchlauf 

Seiten im Durchlauf 

Im Durchlauf scrollt das Display des LSS MasterPort 2 PSU durch verschiedene Diagnoseseiten, die 
einen schnellen Überblick über verschiedene Einstellungen und den Betriebszustand des Geräts 
geben. Durch Drehen des Encoders kann der Durchlauf unterbrochen werden. Durch weiteres Dre-
hen werden die Seiten manuell aufgerufen. Der automatische Durchlauf wird mittels eines blin-
kenden -Symbols rechts oben angezeigt. Beim Wechsel zum manuellen Durchlauf ändert sich 
das Symbol in II. 

Der Durchlaufmodus ist ab Werk eingestellt und stellt die Default-Einstellung dar. Es gibt noch wei-
tere einstellbare Möglichkeiten. Diese werden weiter unten bei den Display-Einstellungen näher 
erläutert. 

Die folgende Tabelle zeigt die Aufstellung der 7 verschiedenen Informationsseiten. Die Seite 0 ist 
dabei die Übersichtsseite.  

 

Seite Display Erklärung 

Seite 0 MasterPort 2 
PSU 

Hersteller, Softwareversion, Hardwarerevision, Datum, Zeit Software 

Seite 1 Serial ArtNet Name, Seriennummer Platine, MAC-Adresse 

Seite 2 Counters Einschaltzähler, Watchdog-Fehler, Betriebsstunden, Betriebstempera-
tur, Maximal gemessene Betriebstemperatur 

Seite 3 NW Info Aktuelle IP-Adresse, Ethernet-Geschwindigkeit & Richtung, Zähler Da-
tenpakete 

Seite 4 IN Aktuelles Routing eingehender Ethernet-Daten an DMX-Outs. 

Seite 5 DMX Aktueller Status der DMX-Ports. 

Seite 6 PSU State Anzeige der an den PowerDMX-Anschlüssen anliegenden Spannungs-    
und Stromwerte. 

 

Wird der Encoder längere Zeit nicht betätigt, kehrt der MasterPort 2 PSU automatisch in den 
Durchlauf zurück. Die Länge des Timeout kann unter Options→Display eingestellt werden (Default 
30s). Monitorbildschirme sind von der automatischen Rückkehr in den Durchlauf ausgenommen. 

 

Dies ist die Defaulteinstellung. Unter Options→Display→Default können auch andere Ein-
stellungen erfolgen. So ist es z.B. möglich, eine Seite des Durchlaufs als festen Screen fest-
zulegen. Ebenso kann ein kurzer Usertext dargestellt werden.  
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Menüstruktur 

 

 
 

Im Grundzustand zeigt das Gerät eine der 7 Informationsseiten. Durch Drücken des Encoderrades 
für die Dauer von 1s gelangt man in das Hauptmenü des LSS MasterPort 2 PSU. Die Menüstruktur 
ist hierarchisch aufgebaut und umfasst Submenüs zur Information, Funktionseinstellungen und all-
gemeinen Geräteeinstellungen. Daraus ergibt sich in der Ebene 1 (rechte Spalte) die Bezeichnun-
gen View, Config und Options. Der Aufbau der Untermenüs wird nun im Folgenden dargelegt. 

 

Monitoring mit dem View-Menü 

Mit den Monitoren im View-Menü erhalten Sie einen Überblick über die aktuellen Einstellungen 
des LSS MasterPort 2 PSU. Aktuelle Ereignisse, Daten-In- und –Output werden ebenso dargestellt 
wie die Merge-Situation. Die Anzeigen im View-Menü verstehen sich als Monitore und sind Echt-
zeit-Anzeigen. Dadurch lassen sie sich problemlos als Überwachungs- und Diagnosetools einset-
zen. 

Ebene 1 Ebene 2 Ebene 3 Ebene 4 
 

View DMX In, Out, Fps Anzeige anliegender DMX-Signale, eingestellter Hold-Werte, gesendeter Pakete 
und eingestellte Framerate 

RDM Port1, 2, 3, 4 Anzeige aktueller RDM-Informationen pro DMX-Port, empfangener Geräteinfor-
mationen 

Network Monitor Port1, 2, 3, 4 Anzeige DMX-Porteinstellungen 

Counters In, Data Anzeige Zähler gesendeter/empfangener Daten 

Data Anzeige Zähler Datenpakete (Pack./s, kByte) 

PSU Port 1…4 …V/…V …A Anzeige der Eingangs-/Ausgangsspannung, Stromlast usw. 

Mode: Anzeige Verhalten bei Schaltschwelle 

Meldungen Diagnosemeldungen entsprechend der Priorität 

     

 
 

Anzeigen im Untermenü DMX 

Das Menü View→DMX gibt einen Überblick über 
die Aktivitäten an den DMX- Anschlüssen. Darge-
stellt werden die DMX-IN, die DMX-OUT und die 
jeweiligen Frameraten des Ports. Der MasterPort 
2 PSU besitzt systembedingt nur DMX-OUT-

Ports. Im Untermenü für alle Anschlüsse können die Signale für jedes Bit hexadezimal oder prozen-
tual dargestellt werden. 
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Anzeigen im Untermenü RDM 

Das Menü View→RDM stellt die aktuellen RDM-
Informationen am jeweiligen Port dar. Nebenste-
hende Abbildung zeigt einen MasterPort 2 PSU, 
für dessen Port 1 RDM eingeschaltet ist (siehe 
Abschnitt Config). Die Inkrementelle Discovery 

hat an diesem Port ein RDM-Gerät gefunden. Mit dem Cursor kann man dieses jetzt anwählen und 
alle RDM-Informationen auslesen. 

 

 

Anzeigen im Untermenü Network 

Im Menü View→Network werden Einstellungen 
und Netzwerkzähler dargestellt. Unter Monitor 
findet man die Netzwerkaktivität der eingestell-
ten Universes und die dazugehörige Priorität. 
Unter Counters findet man die Ethernet-Para-

meter, getrennt nach In- bzw. Out-Parametern und dem Paket-Zähler für Rx und Tx. 

 

 

Anzeigen im Untermenü PSU 

Das Menü View→PSU zeigt den momentanen 
Zustand der Power Supply Unit (PSU). Die bei-
den Abbildungen links zeigen mögliche Schaltzu-
stände dieser Einheit. Im Bild oben ist die PSU-
Einheit für Port 1 ausgeschaltet. Die erforderli-

che PSU-Eingangsspannung ist entweder ausgefallen, oder gar nicht zugeschaltet. Die PSU-Einheit 
soll durch den DMX-Kanal 1 des dem Port zugeordneten Universe schalten. Offensichtlich ist die 
Schaltschwelle von 50% aber nicht erreicht, denn die PSU ist ausgeschaltet, wie am Ende der Zeile 
3 ersichtlich. Zeile 4 zeigt die für den Fall höchstpriorisierte Fehlermeldung an.  

Das Bild unten zeigt eine eingeschaltete PSU. 
24V PSU-Spannung liegt an, der Port 1 wird mit 
annähernd 24V versorgt. Es fließt ein Strom von 
ca. 0,2A. Zeile 4 gibt den Hinweis auf normales 
Betriebsverhalten. Möglicherweise handelt es 

sich bei dem angeschlossenen Gerät um eine LSS GBL Blaulichtleuchte. 

 
 
 
Die Tabelle auf der nächsten Seite gibt nochmal einen Überblick über die möglichen Anzeigen un-
ter View->PSU. 
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Anzeige Bedeutung 

Zeile 2 

x.x V (links) Anzeige PSU Eingangsspannung 

x.x V (Mitte) Anzeige Spannung am PSU-Port 

x.x A Anzeige Laststrom  

x.x A! Anzeige Laststrom nähert sich voreingestellter Schaltschwelle  

 

Zeile 3 

Mode Anzeige der eingestellten Aktion beim Erreichen der Schaltschwelle 

On/Off (rechts) Anzeige des aktuellen Schaltzustands des PSU-Ports 

 

Zeile 4 (folgende Anzeigen treten nie zeitgleich auf) 

No load Es liegt keine Last an. Alle Spannungen sind innerhalb der Parameter. 

Normal load Eine Last ist am PSU-Port angeschlossen. PSU-Port arbeitet innerhalb der 
eingestellten und zulässigen Parameter. 

24V supply failure PSU-Spannungsversorgung liegt nicht an 

24V out of range! Die anliegende PSU-Spannung ist außerhalb der werkseitig voreingestellten 
Parameter. Netzteil prüfen! 

24V from outside! Rückspeisung der Spannungsversorgung von außen. Verbindung prüfen! 

Current Overload Der Laststrom hat die voreingestellte Schaltschelle erreicht oder der Last-
strom war höher als 10A. Der PSU-Port wurde automatisch deaktiviert. 

Short / Overtemp! Ein Kurzschluss liegt vor oder eine Temperatur über den Sicherheitspara-
metern wurde gemessen. Der PSU-Port wurde automatisch deaktiviert. 
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Einstellungen im Config-Menü 

 

Routing – Einstellungen für Datenverarbeitung und Merging 

Menüstruktur 

Ebene 2 Ebene 3 Ebene 4 Ebene 5 Bedeutung 

Routing Port 1..4 Failmode Off, Hold, Zero Einstellung Verhalten bei Empfangsausfall.  

Merge Off, Network Einstellung Merge-Verhalten. 

Precedenc HTP, LTP HPT oder LTP Merging 

Universe (Protokollabhängig) Einstellung des Universe. 

  Sub-
net/Prio-
rity/ 
Universe 

(Protokollabhängig) Einstellung Subnet/Priorität. 

 

   

 

Failmode – Verhalten bei Empfangsausfall 

Auswahl Bedeutung 

Off Bei Empfangsausfall wird der DMX-Out abgeschaltet. 

Hold Letzter empfangener Wert wird unverändert weitergesendet 

Zero Es werden Datenpakete mit dem Wert „0“ gesendet.  
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Einstellung der Mergequellen 

Auswahl Bedeutung 

Mode Off: Der DMX-Out ist abgeschaltet. 

 

Network:  

Es werden die Daten von bis zu 4 Netzwerk-Sendern, die auf dem gleichen Uni-
verse/Subnet senden zusammengefasst. Sollten gleichzeitig von mehr als 4 Sen-
dern Telegramme mit dem Subnetz und Universe dieses Ports anliegen, werden 
nur die ersten 4 erkannten Sender berücksichtigt. Bei Ausbleiben eines Sendersig-
nale wird nach der Timeout-Zeit ggf. ein anderer Sender ermittelt (Prinzip: „wer 
zuerst kommt“). 

 

Weitere Merge-Einstellungen sind bei MasterPort 2 PSU nicht vorhanden, da die-
ser nicht über DMX-Eingänge verfügt. 

Precedence HTP: Merge nach höchstem Wert (Highest takes precedence) 

LTP: Merge nach letztem Wert (Least takes precedence) 

Universe Einstellung des Sende-Universes (lichtprotokollabhängig) 

Subnet Einstellung des Sende-Subnets (lichtprotokollabhängig) 

 

Es gibt verschiedene Möglichkeiten der Auswertung von Änderungen bei LTP. Der Master-
Port 2 PSU bewertet LTP pro Änderung des Einzelkreises im Universe und pro Quelle - das 
ist die genaueste Art der Auswertung. 

 
Im Unterschied zu anderen LSS-Geräten wie MasterPortRM oder MasterGate ist bei Mas-
terPort 2 PSU der LTP-Modus nur für den gesamten OUT wählbar. 
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Prioritäten 

 

Bei Netzwerk-Protokollen mit Prioritäten gibt es folgende Besonderheiten: 

Protokoll Prioritätsbehandlung 

AVAB/UDP 

AVAB/IPX 

Shownet 

Es gibt eine Prioritätsangabe pro Netzwerk-Sender und pro Universe. 

 

Bei Priorität 1…200 gewinnt die Anlage mit der höchsten Priorität. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. Anlagen, die 0 
senden (alte transtechnik-Versionen, DigiPlus usw.) werden immer mit der 
höchsten Priorität zusammen HTP-gemergt. 

sACN Es gibt eine Paket-Priorität pro Netzwerk-Sender und pro Universe 

sowie Einzelkreis-Prioritäten, bei den Anlagen, die das unterstützen (sACN-DD-
Erweiterung von ETC). 

Der MasterPort 2 PSU beherrscht beides; die Kreisprioritäten haben Vorrang, 
falls gesendet (Auswertung der Kreisprioritäten abschaltbar unter Config->Net-
work->Options->sACN ChanPri). Bei fehlenden Kreisprioritäten wird die Paket-
priorität ausgewertet. Kreispriorität 0 wird als "nicht auswerten" behandelt. 

 

Bei Priorität 1…200 gewinnt die Anlage mit dem höchsten Prioritätswert. 

Mehrere gleiche der höchsten Priorität werden HTP- gemergt. Anlagen, die 0 
senden (alte transtechnik-Versionen, DigiPlus usw.) werden immer mit der 
höchsten Priorität zusammen HTP-gemergt. 

 
Die Auswertung der Prioritäten wird selbstverständlich vor der LTP-Auswertung durchgeführt. 
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DMX – Einstellung der DMX- und RDM-Eigenschaften 

Menüstruktur 

 

Werkseinstellungen sind fett und unterstrichen dargestellt. 
Ebene 2 Ebene 3 Ebene 4 Ebene 5 Ebene 6 Beschreibung 

DMX Def Laden Default-Werte aller DMX-Einstellungen für max. Datengeschwindigkeit. Zum 
Aktivieren müssen Einstellungen gespeichert werden. 

RDM RDM Port1-4 Off, On Einschalten von RDM für gewählten Port 

Discovery Port1-4 Off, On Einschalten von RDM-Discovery. 

Intervall 1 -10 - 65535s Einstellung der Intervallzeiten für Discovery. 

Incremen-
tal 

Off, On Einschalten der Incremental Discovery. 

Back-
ground 

Off, On Einschalten des Background Modus für Incremental Discovery. 

Break 90 - 200 - 42280µs Einstellung der Breaklänge. 

MAB 10 - 20 - 42280µs Einstellung der Länge des Mark-after-Break. 

Frames 3 - 44/s Einstellung der Frame-Rate. 

Channels 0 – 512 Einstellung der Byte-Länge des DMX-Protokolls. 

ProtTime z.B. 22.7ms Anzeige der errechneten Protokollzeit in ms 

 

  

 

 

Def – Laden von DMX- und RDM-Defaultwerten 

Mit der Einstellung „Def“ werden die Default-Werte aller Einstellungen, die in diesem Menü und 
den Untermenüs möglich sind, geladen. Es werden keine Default-Werte in anderen Menüs gela-
den und es findet kein Reset des Gerätes statt. 

 

RDM – Einschalten von RDM und Einstellung der RDM-Eigenschaften 

Auswahl Bedeutung 

RDM ●: Schaltet das RDM für den gewählten Port ein. 

○: Schaltet das RDM für den gewählten Port aus. 

Discovery ●: Aktiviert die RDM-Discovery Funktion für den ausgewählten Port. 

○: Deaktiviert die RDM-Discovery Funktion für den ausgewählten Port. 

 

Eine neu angestoßene volle RDM-Discovery verursacht kurzzeitig hohen 
Datentraffic im Netz und kann die DMX-Steuerung beeinträchtigen! 
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Intervall Stellt die Intervallzeiten der Incremental-Discovery in Sekunden ein. 

Incremen-
tal 

Mit dieser Funktion ist RDM-Discovery immer aktiv! Es werden immer Daten ge-
sammelt und Identifizierungsanfragen an alle angeschlossenen Geräte gesendet.  

On: Incremental-Discovery ist immer aktiv. 

Off: Incremental-Discovery ist nicht aktiv. 

Background Mit dieser Funktion arbeitet die inkrementelle Discovery im Hintergrund. Dadurch 
wird das DMX-Signal weniger gestört. Allerdings kann es sein, dass sich die Inter-
vallzeit weit über oben eingestellte hinaus verlängert! 

On: Background-Discovery ist aktiv. 

Off: Background-Discovery ist nicht aktiv. 

 

Einstellen der DMX-Protokolleigenschaften 

Auswahl Bedeutung 

Break Einstellung der Breaklänge von 90 µs…42280 µs  

Liegt die Einstellung außerhalb der RDM-Norm (176...352 µs), wird R! angezeigt! 

MAB Einstellung der Mark-after-Break-Länge von 10 µs…42280 µs 

Liegt die Einstellung außerhalb der RDM-Norm (12...88 µs), wird R! angezeigt! 

Frames Anzahl der pro Sekunde gesendeten DMX-Protokolle. Beim Wert = 44 wird das 
DMX-Signal mit maximaler Geschwindigkeit gesendet. Mit Werten < 44 wird durch 
Dehnung der Zeit zwischen den Bytes die Protokollrate auf den angezeigten Wert 
verringert. 

Channels Einstellung der Länge des DMX-Protokolls 

Die Geschwindigkeit der DMX-Signale ist von diesen Einstellungen abhängig. Die in den Defaults 
hinterlegten Werte entsprechen der maximal möglichen Geschwindigkeit.  

 

Einstellung Defaultwert 

Break 200 µs 

MAB 20 µs 

Frames 44/s 
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Network – Einstellung der Ethernet-Einstellungen 

Menüstruktur 

 Bei Änderungen an fast allen Einstellungen in diesem Menü führt der MasterPort 2 PSU 
einen Neustart durch! 

 

Werkseinstellungen sind fett und unterstrichen dargestellt. 
Ebene 2 Ebene 3 Ebene 4 Einstellung 

 

Network Rx Prot Art-Net, AVAB/IPX, AVAB/UDP/, 
ShowNet, sACN 

Einstellung des Empfangsprotokolls. 

Rx Tmo 1.0 – 2.5 – 999.9 Einstellung Timeout bei Empfang. 

Tx Prot Art-Net, AVAB/IPX, AVAB/UDP/, 
ShowNet, sACN 

Einstellung Sendeprotokoll. 

Tx Rate 20ms, 25ms, 40ms, 50ms, 0.1s, 0.2s, 
0.5s, 1s, 2s, 3s, 4s,  

Einstellung der Mindestsenderate, wenn sich die Sende-Werte 
nicht ändern 

Mode Static manual, Art-Net2/8, Art-
Net10/8, 10.0.0.0, 172.16.0.0, 
172.16.0.0/12, 192.168.0/16, Test1, 
Test2, Test3, DHCP, LinkLocal/16 

Auswahl des IP-Adressformats 

IP 2 Off, Art-Net2/8, Art-Net10/8 Zweiter IP-Alias einstellbar, falls für Art-Net benötigt 

IP  Entsprechend des IP Mode voreingestellte IP-Adresse, deren 
letzte Oktetts teilweise noch editiert werden können 

SN  Entsprechend des IP-Mode voreingestellte Subnet-Maske, de-
ren letzte Oktetts teilweise noch editiert werden können 

GW  Gateway-Adresse, diese muss im Subnet der eingestellten IP-
Adresse liegen 

DN  DNS-Server-Adresse 

Services Telnet Off, On Aktiviert Telnet-Protokoll für Log-Meldungen.  

mDNS Off, On Schaltet das Multicast DNS-Protokoll ein oder aus. 

RDM Off, ArtNet, RDMNet RDM-Kommunikation über Ethernet. 

Hostname  Hostname des Gerätes im DNS-Netzwerk 

Domain Default: „.local“ Domainname  

Options ArtNet 3 Net 0 - 127 Einstellung der ArtNet 3 Network-Adresse.  

ArtNet Bcast Off, On ArtNet wird als Broadcast gesendet. Nur für ältere ADB-
Anlagen.  

ArtNet 4 On, Off Schaltet des Art-Net4-Protokoll ein oder aus. 

Light TxChan 2 - 512 Einstellung der ins Netzwerk gesendeten Kreise im Universe 
(protokollabhängig). 

sACN Discov. Off, On Schaltet das sACN Dicovery-Protokoll ein oder aus. 

sACN Draft Off, On Aktiviert sACN Draft-Modus.  

sACN  
ChanPri 

On,Off Auswertung sACN-Kreisprioritäten 

UDPChksum Rx & Tx, Rx only, Tx only, off Einstellung der Prüfsummenberechnung.  

TCP MSS 536 - 1460 Einstellung der TCP Maximum Segment Size 

 Eth Media AutoNeg, 10 Half, 10 Full, 100Half, 
100Full,  

Einstellung der Ethernet-Übertragungsgeschwindigkeit.  
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Rx Prot – Einstellen des Empfangsprotokolls 

Auswahl Bedeutung 

Rx Prot Einstellung des Lichtprotokolls zum Datenempfang. Folgende Protokolle wer-
den unterstützt: 

• Art-Net • AVAB/UDP • sACN 

• AVAB/IPX • ShowNet  
 

Rx Tmo Einstellung des Timeouts beim Datenempfang 1…999s. 

 
 Bei Wechsel des Empfangsprotokolls wird die Timeoutzeit auf den für das Protokoll emp-
fohlenen Wert gesetzt. Andere Timeoutzeiten, wie für RDM oder Kreisprioritäten, sind da-
von unberührt. 

 

Tx Prot – Einstellen des Sendeprotokolls 

Auswahl Bedeutung 

Tx Prot Einstellung des Sendenetzwerkprotokolls: 

• Art-Net • AVAB/UDP • sACN 

• AVAB/IPX • ShowNet  
 

Tx Rate Einstellung der Mindest-Senderate, wenn sich keine Werte ändern. 

 
 Da der MasterPort 2 PSU keine DMX-Eingänge hat, ist die Einstellung des Sendeprotokolls 
hier ohne Belang. 
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Mode – Einstellen der Ethernet IP-Adresse 

Auswahl Bedeutung 

Static manual: Freie Einstellmöglichkeit der IP-, Subnet- und Gateway-Adresse. Die Einstellung 
bleibt bei Neustart erhalten. 

Art-Net2/8: Art-Net-Adresse im 2er Netz. Adresse und Subnetmaske werden automatisch 
generiert. 

Art-Net10/8: Art-Net-Adresse im 10er Netz. Adresse und Subnetmaske werden automatisch 
generiert. 

10.0.0.0/8: Manuelle Einstellung einer IP-Adresse im 10er Netz (RFC 1918).  

Erstes Byte und Subnetzmaske sind festgelegt. 

172.16.0.0/12: Manuelle IP-Adresse im 172.16er Netz (RFC 1918). 

 Oktett 3 und 4 sind frei einstellbar. 

192.168.0/16: Manuelle IP-Adresse im 192.168er Netz (RFC 1918).  

Oktett 3 und 4 sind frei einstellbar. 

Test1 /24: Manuelle IP-Adresse für Testzwecke (RFC 6890).  

Netzwerk 192.0.2.0. Oktett 4 ist frei einstellbar 

Test2 /24: Manuelle IP-Adresse für Testzwecke (RFC 6890).  

Netzwerk 198.51.100.0. Oktett 4 ist frei einstellbar 

Test3 /24: Manuelle IP-Adresse für Testzwecke (RFC 6890).  

Netzwerk 203.0.113.0. Oktett 4 ist frei einstellbar 

DHCP: Automatische Vergabe einer IP-Adresse durch einen DHCP-Server. 

LinkLocal/16 IPv4LL/ZeroConf Adresse, 169.254.0.0/16 

 

 

 

IP2 – Einstellen einer zweiten IP-Adresse 

Hiermit ist eine zweite Alias-IP-Adresse einstellbar, falls diese für Art-Net benötigt wird und die ei-
gentliche-IP-Adresse in einem anderen Netzwerk ist. 

 

Auswahl Bedeutung 

Off: Zweite IP-Adresse ist deaktiviert. 

Art-Net2/8: Art-Net-Adresse im 2er Netz. Adresse und Subnetmaske werden automatisch 
generiert. 

Art-Net10/8: Art-Net-Adresse im 10er Netz. Adresse und Subnetmaske werden automatisch 
generiert. 
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Einstellen von manueller IP, Subnetmaske, Gateway und DNS-Serveradresse 

Ist im IP-Mode die Einstellung „Static manual“ ausgewählt, kann die IP-Adresse und die Subnet-
maske frei eingegeben werden. Bei allen anderen Einstellungen sind nur einzelne Oktetts änder-
bar, oder es werden die Adressen hier nur angezeigt. 

 

Die Gateway- und DNS-Server-Adresse können immer frei eingestellt werden. 

 

Auswahl Bedeutung 

IP Eingabe/Anzeige der IP-Adresse. 

SN Eingabe/Anzeige der Subnet-Adresse (Netzwerkmaske) 

GW Eingabe/Anzeige der Gateway-Adresse. 

DN Eingabe/Anzeige der DNS-Server-Adresse für RDMnet. 

 
 
 

  
 

Service - Einstellen von Netzwerkdiensten 

Auswahl Bedeutung 

Telnet Schaltet das Telnet-Protokoll (RFC 854) für Logmeldungen ein. 

On:  Aktiviert Telnet 

Off:  Deaktiviert Telnet 

mDNS Schaltet das Multicast DNS-Protokoll (RFC 6762) ein. 

On:  Aktiviert mDNS 

Off:  Deaktiviert mDNS 

RDM Einstellung für RDM-over-Ethernet. 

Off:  Kein RDM über Ethernet 

ArtNet: Art-Net RDM 

RDMNet: RDM-Net nach ANSI E1.33 

Hostname Anzeige eines eindeutigen Netzwerknamens bestehend aus Gerätename und 
Teil der MAC-Adresse. Beispiel: "MasterPort-2-PSU-90cc12" 

Domain Anzeige oder Einstellung eines Domainnamen als Teil eines Fully-Qualified Do-
main Name (FQDN). In internen Netzen immer „.local“. 
Beispiel eines FQDN: "MasterPort-2ba6d9.local" 

Aufgrund interner Einschränkungen ist die Domain bei MasterPort 2 PSU auf 
63 Zeichen beschränkt. 
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Eingabe von Namen (Domainname, Hostname, Gerätename) mittels Encoder 
 
Nach Anwahl des Textfeldes und Anwahl von "Edit" kann man mit dem Encoder 
durch die Textpositionen scrollen (Cursor blinkt nicht). Ganz rechts erscheint ein √ 
Symbol. Fährt man mit dem Cursor auf dieses Symbol und drückt, ist die Eingabe 
beendet. 
Durch Drücken auf eine Textposition ist man in der Zeicheneingabe (Cursor blinkt) 
und kann durch Drehen das Zeichen ändern. Mit Drücken ist man zurück in der 
Positionsanwahl (Cursor blinkt nicht). 
Während der Eingabe ist der gesamte ASCII-Zeichensatz verfügbar. Ungültige Zei-
chen, z.B. in Domainnamen, werden gelöscht und gegebenenfalls durch weiter 
rechtsstehende gültige ersetzt. 

 

Options – Einstellen optionaler Eigenschaften 

Auswahl Bedeutung 

ArtNet 3 Net Eingabe der Artnet 3 Netzwerk-Adresse. Default ist 0. Maximum 127 

ArtNet Bcast Art-Net wird als netzwerkweiter Broadcast gesendet. 

On:  Senden als Broadcast (255.255.255.255) 

  Nicht verwenden, wenn nicht notwendig! 

Off:  Senden als Unicast oder Subnet-Broadcast 

ArtNet 4 Schaltet das Art-Net 4 Protokoll ein. 

On:  Aktiviert das Art-Net 4 Protokoll 

Off:  Deaktiviert das Art-Net 4 Protokoll 

Light TxChan Einstellung der Anzahl der ins Netzwerk gesendeten Kreise des Universe.  

Nur sACN und Art-Net unterstützen im Protokoll die Angabe der Sendebytes. 

sACN Discov Schaltet das sACN Discovery-Protokoll ein. 

Nur für Lichtanlagen, die dies benötigen. 

On:  Aktiviert das sACN Discovery-Protokoll 

Off:  Deaktiviert das sACN Discovery-Protokoll 

sACN Draft Auswahl des unterstützen sACN-Protokolls 

On:  sACN nach Standard E1.31 Draft 

Off:  sACN nach Standard E1.31  
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UDPChksm Einstellung zur Berechnung der Prüfsummen von UDP-Datenpaketen 

Rx & Tx Prüfsummen für empfangene und gesendete Pakete 

Rx only  Prüfsummen nur für empfangene Pakete 

Tx only  Prüfsummen nur für gesendete Pakete 

Off  Prüfsummenberechnung aus 

TCP MSS TCP Maximum Segment Size 

Defaulteinstellung nur ändern, wenn notwendig. 

EthMedia Einstellung der Übertragungsgeschwindigkeit 

Autoneg. Automatische Ermittlung der Übertragungsgeschwindigkeit 

10 Half  10 MBit/s Half Duplex 

10 Full  10 MBit/s Full Duplex 

100 Half 100 MBit/s Half Duplex 

100 Full 100 MBit/s Full Duplex 

 

 

 

 

PSU – Einstellung von PowerDMX und Stromüberwachung 

Menüstruktur 

Ebene 2 Ebene 3 Ebene 4 Ebene 5 
 

PSU Options TurnOffTime 0-3,0-10,0s Einstellen der Zeit zwischen Erreichen des Grenzwertes und 
Abschalten des Kanals. 

Port 1…4 Switch-Mode Off, On, Sense, DMX Einstellen des Schaltverhaltens 

Max.Current 0-8,0-10,0A Einstellung des Grenzwertes für die Stromüberwachung. Die 
Einstellung erfolgt in 0,1A Schritten.  

DMX Channel 1-512 Einstellung der DMX-Adresse für die Steuerung des Power-
DMX-Port.  

 

  
 
 

Einstellen der Abschaltzeit 

Auswahl Bedeutung 

TurnOffTime Einstellen des Zeitraums zwischen dem Erreichen des Grenzwertes und dem Ab-
schalten des Kanals. Diese Einstellung ist wichtig für angeschlossene Geräten mit 
einem hohen Einschaltstrom. 
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Einstellen von Steuerung und Abschaltung der Power-DMX Anschlüsse 

Auswahl Bedeutung 

Switch-Mode On: Servicemodus! Nicht im normalen Betrieb nutzen! 

Die Abschaltung bei Überstrom ist deaktiviert. 

Sense:  

Der Power-DMX-Port wird automatisch abgeschaltet, wenn die ein-
gestellte Begrenzung der Stromstärke oder die maximale Strom-
stärke überschritten wird.  

DMX: Die Stromüberwachung ist aktiv und entspricht den Einstellungen 
aus "Sense". 

Off: Der Power-DMX-Port ist manuell ausgeschaltet. 

Rücksetzen der Stromüberwachung ist mit kurzzeitigem Aus- und Einschalten 
des DMX-Kreises von Fern möglich. 

 
Ist der MasterPort 2 PSU im normalen Betriebszustand (Durchlauf-Mode), so wird bei allen Ände-
rungen der PSU-Einheit der PSU-Bildschirm angezeigt. Hier sind dann die Fehlermeldungen und 
der Status ersichtlich. 
 
 

 

Der Betrieb mit der Switch-Einstellung „On“ ist ausschließlich für den Service vorge-
sehen! Ein dauerhafter Betrieb mit mehr als 10 A Dauerlast kann zur Zerstörung des 
MasterPort 2 PSU und der gesamten Lichtanlage führen! 

  

 

Einstellung Sense oder DMX: Wurde die eingestellte Stromstärke überschritten und 
der MasterPort 2 PSU automatisch abgeschaltet, muss ein manueller Reset auf dem 
angezeigten PSU-Bildschirm durch Drücken auf den Encoder durchgeführt werden. 
Dann beginnt die TurnOffTime erneut zu laufen. 

  

 

Einstellung DMX: Wurde die eingestellte Stromstärke überschritten und der Mas-
terPort 2 PSU automatisch abgeschaltet, so kann die Stromüberwachung auch 
durch ein kurzzeitiges Aus- und Einschalten des DMX-Kreises aus der Ferne zurück-
gesetzt werden. Alle Einstellungen bleiben dabei erhalten. 

 
 

Einstellen des Grenzwertes der Stromüberwachung 

Auswahl Bedeutung 

Max.  

Current 

Einstellung des Grenzwertes der Stromüberwachung. Schaltschwelle für die Strom-
überwachung. Die Einstellung erfolgt in 0,1 A Schritten. 
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Einstellen des DMX-Kanals für den PowerDMX-Anschluss 

Auswahl Bedeutung 

DMX 
Channel 

Einstellung der DMX-Adresse für die Steuerung des PowerDMX-Ports. 

 
 

Betriebseinstellungen im Options-Menü 

 

Laden von Default-Werten und Geräte-Reset 

Ebene 2 Ebene 3 Beschreibung 

Defaults No, Yes Laden der Betriebseinstellungen. 

Reset 
 

Auslösen eines Geräte-Reset. 

 

Default/Werkseinstellungen 

Die Werkseinstellungen des MasterPort 2 PSU sind: 

 

Ethernet 

 

Einstellung Default-Wert 

Netzwerkprotokoll: sACN (Senden und Empfangen) 

IP-Mode: Art-Net-10 Netzwerk 

IP: Nach Art-Net Standard (10.x.y.z) 

2. IP aus 

Netzwerk-Maske: 255.0.0.0 

Gateway: 10.0.0.254 

DNS-Server 10.0.0.254 

Mindest-Senderate: 0,5/s 

Empfangstimeout: 2,5 s 

Services (Dienste): aus 

Hostname: MasterPort-2-PSU-<letzte 3 Oktetts der MAC-Adresse> 

Domain: local 

Options: Art-Net 3 Network: 0 

Art-Net 4: ein 

sACN-Kreisprioritäten: ein 

UDP-Prüfsummen: ein 

TCP MSS: 1460 

Alles nichtgenannte aus. 
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DMX 

 

Einstellung Default-Wert 

Routing Port 1…4 : Universe 1 bis 4 

Merge: Network 

Precedenc HTP 

RDM ausgeschalten 

DMX-Out Timing: Break:  200 µ 

MAB:  20 µ 

Framerate: 44 / s 

Art-Net Short Name: MasterPort 2 PSU 

Art-Net Long Name: MasterPort2 PSU v2.12 Oct 04 2023 14:17:42 (Beispiel) 

 
 
 

Display – Einstellung aller Anzeigen 

Ebene 2 Ebene 3 Ebene 4 Beschreibung 

Display Short Name Zeichenfolge Darstellung des Gerätenamens 

Contrast 0 -50 - 100% Einstellung des Kontrastes im Display 

MenuTimeout Off, 15 s, 30 s, 1 Min, 3 Min, 
5 Min, 10 Min, 15 Min, 20 
Min, 30 Min, 45 Min, 1 h, 2 
h, 3 h, 4 h, 6 h, 8 h, 12 h, 24 
h 

Einstellung der Zeit bis Menü in Durchlauf zurückkehrt, wenn keine Änderungen einge-
stellt werden. Achtung! Nicht gespeicherte Einstellungen werden verworfen! 

ScreenSaver Off, 15 s, 30 s, 1 Min, 3 Min, 
5 Min, 10 Min, 15 Min, 20 
Min, 30 Min, 45 Min, 1 h, 2 
h, 3 h, 4 h, 6 h, 8 h, 12 h, 24 
h 

Einstellung der Zeit bis die Hintergrundbeleuchtung nach dem letzten Drehen des En-
coders ausgeschaltet wird. 

Front LEDs Off, On Einstellung ob Betriebs-LEDs mit dem Display abgeschaltet werden 

Events Off, On Einstellung, ob Display (und Betriebs-LEDs) durch Änderungen an den Anschlüssen 
"aufwachen" sollen. 

Default Scroll, Definition eines Defaultscreens, der nach dem MenuTimeout angezeigt wird. Hier 
Scrolling aller Seiten 

UserTxt Definition eines Defaultscreens, der nach dem MenuTimeout angezeigt wird. Hier Aus-
wahl eines festgelegten Textes als permanente Anzeige. 

FixScreen 0 - 6 Definition eines Defaultscreens, der nach dem MenuTimeout angezeigt wird. Hier Aus-
wahl eines Info-Screens aus dem Durchlauf und dessen permanente Anzeige 

 

Security – Zugriffseinschränkungen festlegen 

Ebene 2 Ebene 3 Ebene 4 Beschreibung 

Security Pin Off, On Eingabe einer PIN zum Sperren des Gerätezugangs. 

RemoteCtl Off, On Einstellung ob Gerät über ArtNet angesprochen und einge-
stellt werden kann (ConfigStudio/DMX-Workshop). 
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Debug 

Die Debug-Funktionalität des MasterPort 2 PSU dient der Fehlersuche. Im Unterverzeichnis Log 
können Meldungsprioritäten und Log-Ziele (z.B. Telnet oder Syslog) und bis zu 32 Log-Quellen aus-
gewählt werden. Zudem kann hier das geräteinterne Crashlog gelöscht werden. 

 

  
  

Die Einstellungen sollten hier mit Be-
dacht gewählt werden. Bitte immer 
nur die Quellen und Ziele auswählen, 

die auch benötigt werden. Die Menge an Infor-
mationen ist sonst so groß, dass sich die Feh-
lersuche verkompliziert. 

 
 
 
 
 

 

 
 
 

Konfiguration mit ConfigStudio 
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Konfigurationssoftware ConfigStudio 

Die Konfiguration des MasterPort 2 PSU kann auch über die Konfigurationssoftware LSS ConfigStu-
dio erfolgen. ConfigStudio steht als kostenlose Software auf der Homepage der LSS als Download 
zur Verfügung. Die Grundlagen der Software werden im Handbuch „ConfigStudio“ erläutert. Das 
Handbuch MasterPort 2 PSU setzt voraus, dass diese Grundlagen beherrscht werden.  

 

Der MasterPort 2 PSU wird ab der Firmware-Version 2 grundsätzlich nur noch mit der Software 
ConfigStudio konfiguriert. Die ältere Version ConfigCore ist hierfür nicht mehr geeignet.  

ConfigStudio besitzt eine Hauptoberfläche, die Geräte in einer Liste anzeigt und grundlegende In-
formationen über diese enthält. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Geräteliste 

 

Geräte 

ConfigStudio sucht in allen erreichbaren Subnetzen nach Geräten, die auf ArtPoll-Netzwerkpakete 

antworten. Gefundene Geräte werden mit IP-Adresse und ArtNet-Kurzname dargestellt. 

 

Jeder Geräteeintrag erhält zusätzlich ein kreisförmiges Symbol, welches den Erreichbarkeitsstatus 

farblich darstellt. Die Farben haben folgende Bedeutung: 

 

1 

 

 

2 
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          Grün: Gerät ist aktiv und antwortet auf Statusabfragen 

 Gelb: Eine Antwort des Gerätes steht seit mindestens 4 Abfragen aus 

 Rot: Gerät ist inaktiv und hat auf die letzten Abfragen keine Reaktion gezeigt 

 Blau: Gerät wurde manuell hinzugefügt und existiert nicht im Netzwerk oder Phantommo-

dus (Fortlaufende Abfragen deaktiviert) ist angeschaltet 

Die meisten LSS-Geräteeinträge haben auch einen ausklappbaren Menüpunkt namens Portkonfi-

guration. 

 

 

Dynamische Fenster 

 

Im linken Bereich des Programmfensters finden Sie die wesentlichen Funktionen und Informatio-

nen für das momentan ausgewählte Gerät. Der Inhalt dieses Fensters bezieht sich immer auf das 

aktuell aktive Gerät in der Liste und verändert sich entsprechend. 

Im Normalzustand befinden sich hier Funktionstasten, Basisinfos und ein Beispielbild. 

Funktionstasten 

 

Die Funktionstasten bieten schnellen Zugriff auf wichtige 
Funktionen: 

• Ident: Sendet ein Kommando an das Gerät, worauf-

hin es sich akustisch und optisch bemerkbar macht. 

Muss zum Fortfahren nach Aktivierung wieder deak-

tiviert werden. 

• Default: Setzt das Gerät auf Werkseinstellungen zurück. Hierbei gehen alle individuellen 

Einstellungen verloren! 

• Reset: Startet das Gerät neu. 

• Eigenschaften: Öffnet das Konfigurationsfenster, mit dem alle veränderbaren Eigenschaf-

ten des Gerätes (bis auf DMX-Ports, siehe Portkonfiguration) angepasst werden können. 

 

  

Basisinfos  

 

In Tabellenform werden hier die wichtigsten Infos des ausgewählten Gerätes dargestellt: 

• Langname: Der Art-Net Langname des Gerätes 

(enthält meist Gerätetyp, Firmwareversion, Revi-

sion und Firmwaredatum) 

• Kurzname: Der Art-Net Kurzname (Standardmäßig 

Gerätetypbezeichnung) 

• Standort: Der Standort des Gerätes (optional, 

wenn leer „unbestimmt“) 
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• IP-Adresse: Aktuell aktive IPv4-Adresse des Gerätes 

• MAC-Adresse: MAC-Adresse des Gerätes im Hexadezimalformat 

• Firmware Version: Firmwareversionsnummer des Gerätes 

 

Texte mit diesem Symbol können an der jeweiligen Stelle bearbeitet, und für das entspre-
chende Gerät abgeändert werden. 

 

Portkonfiguration 

 

 

Wenn in der Geräteliste ein Geräteeintrag „aufgeklappt“ und Portkonfiguration ausgewählt 
wurde, verändert sich der Inhalt des dynamischen Fensters. 

 
 

Die Ports des ausgewählten Gerätes werden grafisch 
dargestellt und dienen als Schaltflächen, um den ge-
wählten Port genauer zu konfigurieren.  

 

Alternativ können wichtige Porteigenschaften über die 
Elemente unterhalb der Darstellung angepasst werden: 

 

Enable aktiviert oder deaktiviert die physische oder netz-
werkseitige Ausgabe von DMX-Daten. 

Universe enthält das Netzwerk-Universe, welches zum Senden/Empfangen von Lichtdaten ver-
wendet werden soll. 

RDM aktiviert/deaktiviert RDM-Funktionen am physischen DMX-Port. 

 

 

Die farbliche Umrandung des dargestellten Ports visualisiert dabei den aktuellen Status: 

 

grau:   Port ist inaktiv - sendet/empfängt keine DMX-Daten 

blau:   Zero/Backup - Port empfängt gerade keine DMX-Daten, sendet aber einen Grund-

  Wert von 0 

gelb:   Hold - Port empfängt gerade keine DMX-Daten, sendet aber weiterhin die zuletzt 

  erhaltenen Daten 

orange:  RDM - Port empfängt/sendet RDM-Pakete  

grün:   Port ist aktiv und sendet oder empfängt DMX-Daten 
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Wird einer der Ports angeklickt, erscheint das 
folgende Fenster. Es beinhaltet die Gesamt-
heit der Einstellungen des gewählten Ports. 

 

 

 

 

 

 

 

 

 

 

 

 

Übertragung von Einstellungen 

Einstellungen an den Geräten werden nicht direkt und in Echtzeit vorgenommen, sondern nach 
Bestätigung des Anwenders. Dies geschieht zum einen, um den Datenverkehr im Netzwerk gering 
zu halten und um Fehler bei den Einstellungen zu minimieren. Ein Hinweis unter der Geräteliste 
zeigt an, dass Änderungen lokal vorgenommen wurden und gesendet werden könnten  
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Das Eigenschaftsfenster 

Im Fenster Eigenschaften lassen sich alle Einstellungen, die nicht zu den physischen DMX-Ports ge-
hören, anpassen. Diese Einstellungen sind in den folgenden Abbildungen dargestellt. 

Für Support-Anfragen sind die Daten aus der Kategorie Informationen von besonderer Bedeutung. 
Anhand dieser Werte kann der Techniker Geräteeigenschaften erkennen, die für die Fehlersuche 
oder auch die Bestimmung der richtigen Firmware-Datei von Nutzen sind.  
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Die Kategorie Firmware-Update beinhaltet die Einstellungen, die für die Aktualisierung der Be-
triebssoftware des MasterPort 2 PSU wichtig sind. Bitte updaten Sie diese Software nur nach Rück-
sprache  

 

Über einen Link (grüne Markierung) kann die ak-
tuelle Firmware von der LSS-Website herunterge-
laden werden. Hierfür ist ein Kennwort erforder-
lich. 

 

Durch Klicken auf den Button mit dem Fragezei-
chen (rote Markierung) erhalten Sie Informatio-
nen zu Fehlern, die während des Update-Prozes-
ses aufgetreten sind. 
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Service 
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Kontaktaufnahme 

 

Falls Probleme beim Betrieb des LSS MasterPort 2 PSU auftreten, sollten die Beschreibungen und 
Hinweise in diesem Handbuch zur Fehleranalyse und Fehlerbehebung weiterhelfen. Sollte dies 
nicht der Fall und es werden weiterführende Hilfestellungen benötigt, wenden Sie sich an den LSS-
Service. 

 

Bei der Kontaktaufnahme sollten folgende Informationen vorliegen: 

 

- Ort der Gesamtanlage und Position des MasterPort 2 PSU 

 

- Ausführliche Fehlerbeschreibung 

 

- Ausführliche Beschreibung der bisher erfolgten Fehlersuche 
 

- Beschreibung zusammenhängender System- oder Geräteprobleme 

 

 

Sollte eine Einsendung des Gerätes zu LSS erfolgen, so bitten wir, den Reparaturbegleit-
schein von unserer Website herunterzuladen und ausgefüllt der Sendung beizulegen. Die-
ses Formular steht unter Kontakt→Reparaturservice zum Download bereit. 

 

 

Kontaktadresse: 

LSS GmbH 

Licht-, Steuer- und Schaltanlagenbau GmbH 

Sonnenstraße 5 

D-04600 Altenburg 

Tel.: +49 3447 83550 

Fax: +49 3447 861779 

mail@lss-lighting.de 
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Anhang  
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Technische Daten 

Allgemeine technische Daten 

Bauart: Panel-Einbaugerät 
 

Gerät Abmessung Gewicht 

Einbaugerät für Gehäuse 130 x 68 x 155 mm ca. 0,7 kg 

Einbaugerät für den Kanal-Einbau 130 x 68 x 150 mm ca. 0,7 kg 

Einbaugerät für Aufputzgehäuse 200 x 76 x 155 mm ca. 3,0 kg 

Portable mit Schutzbügel 215 x 213 x 175 mm ca. 4,5 kg 

 
EMV-Standards: EN 55022, class B, FCC part 15, level B 
RoHS: konform 
Lieferumfang: Fertiggerät 
 
CPU-Typ: Infineon XE169 
Taktfrequenz: 80 MHz 
Kühlung: lüfterlos, passiv 
Stromversorgung: 24 V DC oder PoE nach IEEE 802.3af 
Leistungsaufnahme: 
Konfiguration: Menüsystem mit Display und Encoder 
 

Stromversorgung PSU:   24 V DC  

Betriebstemperatur: 0 °C – 40 °C 
Leistungsaufnahme: 7- 14 W 
 
 

Bestellnummer 

5063 ohne rückwärtige DMX- und PowerDMX-Anschlüsse 

5263 mit rückwärtigen DMX- und PowerDMX-Anschlüssen 
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Netzwerk 

DMX 

Allgemein 

DMX-Protokoll DMX512-A 

Standards: USITT 1990, DIN 56930-2, ANSI E1.11, ANSI E1.20,  

ANSI 1.37-1(2012), ANSI 1.37-2(2021), ANSI 1.37-
7(2019) 

Baudrate: 250 kbps 

 

DMX: Frontseite: 4x 5-polig XLR female ein-
zeln potentialgetrennt 
mittels Optokoppler 
(ISOLATED nach ANSI 
E1.11 A1) 

 Rückseite: 4x 3-polig  
Ohne Potentialtrennung! 

Power-DMX: Frontseite: 4x 4polig XLR female ein-
zeln potentialgetrennt 
mittels Optokoppler 
(ISOLATED nach ANSI 
E1.11 A1) 

 Rückseite: 4x polig male 
Ohne Potentialtrennung 

Max. Laststrom pro Anschluss: Frontseite: 10 A 

 Rückseite: 10 A 

Isolationsspannung: 1000 V DC 

Isolationswiderstand:  109  

EMV: Filterbeschaltung nach Stand der Technik an allen 
Ein- und Ausgängen 

Terminierung: werksseitig intern 

 

Empfang 

 Der MasterPort 2 PSU hat systembedingt keine 
DMX-IN 

 

Senden 

Startcode: 0 (Licht), CCh (RDM) 

Protokollänge: Startcode + 2…512 Werte 

Minimale Protokollzeit: 22,4 ms 

Gesendete Protokolle / s: 3…44 
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Breaklänge: 90…42280 µs (einstellbar) 

Mark After Break: 10…42280 µs (einstellbar) 

Pause nach Startcode: 25 µs (wenn Framerate <44 eingestellt ist) 

 

Ethernet 

Allgemeines 

Schnittstelle: RJ-45, IEEE-Belegung für 100BaseTx und Power-over-
Ethernet nach IEEE 802.3af 

Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 

Duplex-Mode Auto-MDI/MDIX 

Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-
Mode werden im Display angezeigt 

Lichtprotokolle: Art-Net 4 (ArtisticLicence), AVAB-IPX (AVAB, 
transtechnik, LDDE,..), AVAB/UDP (transtechnik), 
ShowNet (Strand Lighting) 
sACN (ANSI E1.31 R2018), sACN DD Priority-per-
Channel, RDM-Net ANSI E1.33 (2019) 

Weitere Netzwerkprotokolle: ARP, TCP/IP, IPX, UDP, IGMPv2, Syslog, mDNS, 
Telnet 

 

Empfang 

Max. Paketrate: >1000/s (bei 1 Lichtframe/Paket) 

Min. Durchlaufverzögerung: 4 s 

Max. Durchlaufverzögerung: 22,7 ms 

Max. Abstand zwischen 2 Protokollen: 1...999 s  (Halten per DMX-Out einstellbar) 

 

Senden 

Senderate bei Wertänderung: maximal aller 20 ms 

Senderate ohne Wertänderung: 20 ms … 4 s  (einstellbar) 
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Anschlussbelegung 

DMX-Ports 

DMX-Frontseite 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 DMX_Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE kann über die Schirmung geführt werden 

 

DMX-Rückseite 

 

Pin Belegung 

1 DMX_Ground 

2 Data - 

3 Data + 

4 Spare 

 
 

PowerDMX Frontseite 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Ground 

2 Data - 

3 Data + 

4 +24V DC 

 

PE kann über die Schirmung geführt werden 
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PowerDMX Rückseite 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Ground 

2 Data - 

3 Data + 

4 +24V DC 

 

PE kann über die Schirmung geführt werden 

 

 

Ethernet 

Der Ethernet-Anschluss unterstützt Power-over-Ethernet nach IEEE 802.3af 

 

Pin Belegung 

1 Rx + 

2 Rx - 

3 Tx + 

4 V + 

5 V + 

6 Tx - 

7 V - 

8 V - 

S Kabelschirm 

 


